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The Quality Management System of the manufacturer is approved to ISO9001:2000 for 
the design, manufacture, stockholding, in-house repair and site servicing of non-contact 
temperature measuring instrumentation.  
 
Sierra Pacific Innovations Corp reserves the right to make changes and improvements for 
the product described in this manual without prior notice. 
 
Copyright 
© Sierra Pacific Innovations Corp, all rights reserved worldwide. No parts of the software 
including source code may be reproduced, transmitted, transcribed or translated into any 
language or computer language in any form or by any means, electronic, magnetic, optical, 
manual or otherwise, without prior written permission. 
 
This manual must not, in whole or part, be copied, photocopied, reproduced, translated or 
transmitted by any electronic medium or machine readable form without prior consent, in 
writing. 
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Introduction 

This publication provides the necessary information required to understand and use the 
analysis software IrAnalyser® to analyze static image files or real-time video taken by our 
cameras. 

It is recommended that the User Manual is read thoroughly before using the software.   

It is also advisable that all User Manuals and Instruction Leaflets supplied are kept readily 
available, for reference when the software is in general use. 

Technical Support 

Technical support for the software can be obtained by either contacting the 
address/telephone number on the cover of this User Manual, or by Email to the following 
address: overseas@guide-infrared.com   

Feedback to Us 

We have tested and verified the information in this manual to the best of our abilities. Yet 
as we are committed to continuous development and progress, you might find features of 
the product have been changed since the time of printing. Please let us know about any 
errors you find and your suggestions for modifications for future editions by either 
contacting the address/telephone number on the cover of this User Manual, or by Email to 
the following address: overseas@guide-infrared.com   
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Installing IrAnalyser®  

 
System Requirements 
Operating system: Window 2000 or higher (IE5.0 or higher), included: 

Windows2000 

WindowsXP 

WindowsVista 

Software: Microsoft® Office 2000 or higher, including: 

Microsoft Office 2000 

Microsoft Office XP 

Microsoft Office 2003 

Microsoft Office 2007 

 
Minimum hardware requirement:  

Processor Pentium3 1G  

RAM 256M (512M recommended) 

Free available space on hard disk 
drive 

100MB 

Display Super VGA (800 x 600) or higher; or 
higher resolution monitor with 16-bit colors 
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Install IrAnalyzer®  

It is recommended that you close down all applications before installing the program. 

 Insert the CD-ROM containing the program into the CD-ROM driver on your PC 

 Follow the on-screen instructions 

Note:  

 Please double click the file “setup.exe” on the CD-ROM if the installation does not 
begin automatically 

 Without changing the default directory to install the program, the installation procedure 
will allow the program to be installed under C: \Program files\Guide IrAnalyser 

 The installation procedure will add a shortcut icon Launch Guide IrAnalyser to the 
desktop and Start (All programs\IrAnalyser\ Launch Guide IrAnalyser)  

 

 

Uninstall IrAnalyzer®  

It is recommended that you close down all applications before uninstalling the program. 

 Insert the CD-ROM containing the program into the CD-ROM driver on your PC 

 Follow the on-screen instructions 

 When the dialog box below is displayed, select Remove, click Next and then follow the 
on-screen instructions.     
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Using IrAnalyzer®  

 
Choosing a language for IrAnalyzer®  
After you install the program in your PC and run the program, the program will open with 
the default language. The default language is the one used by your Operating system.  
 
To change the language, go to command Language under menu View and then choose a 
language you need for the program. A checkmark √ will appear in front of the selected 
language.  
 
After changing the language, the program will prompt you restart it. Choose Yes to restart 
it immediately or No to go on using the original language.  
 
Before IrAnalyzer closes, a dialog displays as follows 

 
Open the latest image: open the latest image automatically when restarting the IrAnalyzer 
Open the Device Video: open the latest infrared video automatically when restarting 
IrAnalyzer 
Don’t show any file: don’t show any file when restarting IrAnalyzer 
Don’t show this dialog again: don’t show this dialog in IrAnalyzer again 
 
Get to know IrAnalyzer® interface  
The program has only one Windows-based interface.  
 
After starting the program, the program interface below will appear. It consists of eight 
parts: Tip of the day, Menu bar, Toolbar, Palette bar, Information bar, DataView bar, 
Gauge bar and Status bar. Below please find detailed introduction to each part.  
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Tip of the Day 
The dialog box displays several tips about the program features and how to use them. 
You can select Next Tip to go through the tips or Close to close down the dialog box. Or 
you can get cancel the selection of “Show Tips on StartUp” to modify the program to not 
open the dialog box next time you run the program. 

 
 
Menu Bar 
Menu bar consists of eight sub-menu options, including File, Image, Filter, Measure, Tools, 
View, Window and Help. 

 

Keep the left button of the mouse depressed and by moving the mouse will allow you to 
move the menu bar to any desired place.   
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Toolbar 
The toolbar is displayed across the top of the program window, below the menu bar. The 
toolbar provides quick mouse access to major functions in the program. 

 
Keep the left button of mouse depressed and moving the mouse will allow you to move 
the toolbar. 
 
Note:  
 To hide or display the toolbar, click Toolbar in the View menu. 

 
Palette Bar  
There are nine palettes available. Moving the mouse across them will accordingly change 
the colors of the current image file and gauge color. Clicking a certain palette will confirm 
the selection. Move the mouse away without clicking a certain palette and the current 
open image file will still be in the original color.   

 
Keep left button of the mouse depressed and moving the mouse will allow you to move 
the palette bar to any desired place. 
Note:  
 To hide or display the palette bar, click Palette Bar in the View menu or click the 

shortcut  in the toolbar of View menu 
 

Information Bar 
Displays information of the current open image file, such as emissivity, humidity, date and 
time when it was created.  
While moving the mouse within the image file, coordinates and temperature of the image 
pixel where the mouse lies will be displayed in the Information bar. 
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Note:  
 To display or hide the information bar, click the Information Bar in the View menu.  

 Clicking  on the right top of the information bar can hide Information Bar as well.  

DataView Bar 
Display temperature measurement result of analysis objects (spots, lines, circles, 
rectangles, polygons, or delta-two spots) added to the current open image file if any.  
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Keep left button of the mouse depressed and moving the mouse will allow you to move 
the DataView bar to any desired place.  

 

Note:  

 To display or hide the DataView bar, click DataView Bar in the View menu.  

 Clicking  on the right top of the DataView bar can hide the DataView bar as well. 

 

Gauge Bar  

 

 

It displays different colors according to the different temperatures. 

Note:  

 To hide or display the gauge bar, click Gauge Bar in the View menu.  

 

Status Bar 

The status bar is displayed at the bottom of the program window.  

The left area of the status bar describes actions of menu items as you use the up and 
down arrow keys to navigate through menus. This area similarly shows messages that 
describe the actions of toolbar buttons as you press them, before releasing them. If after 
viewing the description of the toolbar button command you wish not to execute the 
command, then release the mouse button while the mouse pointer is off the toolbar 
button.  
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Note:  
 To display or hide the status bar, use the Status Bar command in the View menu. 

 
 
Use Commands under Menu Bar  
 
File Menu  
The File menu offers the following commands: 
Open Image Open an existing image file 
Save Image  Save an opening image file 
Save Image As  Save an open image file with palette or without palette in JPEG or  

BMP image file 
Close Close an open image file 

Setup Set the directory of thermal image and video and other relevant 
information 

Report Word:  
New: Create a Microsoft® Word report with the program and 
Microsoft® Word for the current opening image file; 
Open: Open an existing Microsoft® Word report 
Report Wizard: Create a Microsoft® Word report step-by-step for the 
current opening image file with pre-defined report templates 
Excel:  
New: Create a Microsoft® Excel report with the program and 
Microsoft® Excel for the current opening image file; 
Open: Open an existing Microsoft® Excel report 
Freport： 
Create a report with the program for the current open image file in 
other type file. 

External Device 
Manager 

Delete saved image files in MobIR® M series camera， TP8 
camera,EasIR-4 camera or download them from MobIR® M series 
camera，TP8 camera，EasIR-4 camera to your PC 

Exit Exit the IrAnalyzer® program 
 
Open Command  
Use this command to open an existing image file in a new window. You can open multiple 
image files at one time. Use the Window menu to switch among the multiple opening files. 
For more details, please refer to Window 1, 2, ... command. 
Note:  
 Clicking shortcut  in the toolbar will open an existing image file as well. 
 As many as 12 images may be opened at a time 
 On the title bar of an open image file window, it shows the file name. 
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Save Command 
Use this command to save an opening image file and the measurement analysis in its 
current name and directory.  
Note:  
 If the opening image file is of IMG format, a prompt whether to save it into IRI format 

will appear before saving it. 
 You have to save the IMG file as IRI format, then the analysis result can be saved into 

the file together. The analysis information can’t be saved in image files of IMG format 
 If the opening image file is of JPG format, the analysis result and the JPG file will be 

saved together in JPG format. 
 Clicking shortcut  in the toolbar will save an opening image file as well. 

 
Save Image As Command 
Use this command to save an opening image file with pallet or without pallet in JPEG or  
BMP image file. 
Note:  
 You cannot measure temperature of pixels in the re-saved BMP or JPG image files 
 To save the visual image of the current thermal image, please select the visual image 

firstly and then click the right bottom of mouse, a menu of “Copy, Save as, Close” will 
appear. Selecting “ Copy” will copy the visual picture to other document, Selecting 
“ Save as” will save the visual picture as another BMP or JPG file, Selecting “ Close” 
will close the visual picture 

 
Close Command 
Use this command to close an opening image file. 
 
Setup Command  
Use this command to set a directory on the hard disks to store thermal images, reports, 
report templates and time format displayed in the information bar.  

 
After saving the setup, the program will automatically go to the directory when opening 
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thermal images or reports and when creating reports using the Report Wizard.   
 
Report Command  
This command includes two sub-commands: Word and Excel.  
Word includes three sub-commands as follows: 
New: Use this command to create a Microsoft® Word report with the program and 
Microsoft® Word for the current opening image file; 
Open: Use this command to open an existing Microsoft® Word report 
Report Wizard: Use this command to create a Microsoft® Word report step-by-step for 
the current opening image file 
 
Excel includes two sub-commands as follows: 
New: Use this command to create a Microsoft® Excel report with the program and 
Microsoft® Excel for the current opening image file; 
Open: Use this command to open an existing Microsoft® Excel report 
 
Note:  
 The command Report wizard is only available after opening an image file.  

The program works together with Microsoft® Word& Excel to create reports. 
 
External Device Manager 
This command contains two sub-commands M Series Device, TP serious Device and 
EasIR serious. Using this command can delete image files saved in MobIR M series 
camera or TP serious Device and EasIR serious or download them from the camera to 
your PC. 
 M series Device 
After installing the USB driver and connecting MobIR® M series camera to your PC, 
choosing this command will open a dialog box below for you to download some files to PC 
or delete all the image files.  

 



User Manual                                                                    

The dialog box contains three parts: MobIR M series Camera Information, Sync Time and 
File Transfer. 
MobIR M series Camera Information 
Software Version: Indicate software version of MobIR M series camera.  
Hardware Version: Indicate hardware Version of MobIR M series camera.  
Serial Number: Indicate serial number of MobIR M series camera 
Total Files: Indicate total file number saved in MobIR M series camera.  
Sync Time 
Use this command to synchronize time shown on MobIR M series camera with PC.  
File Transfer  
Get file from……to: Appoint the file range as per file numbers which will be transferred to 
PC. 
PC store directory: Appoint store directory for the files in PC. 
Click button Read to transfer files to PC. Or Clicking button Delete ALL will eliminate all 
the image files from the built-in flash memory of MobIR® M series camera. Click button 
Close can exit the command.  
Note:  
 This command is unavailable unless a MobIR M series camera is powered on and 

connected to your PC and the USB driver is installed in your PC.  
 You can connect MobIR M series camera to your PC through the USB extension cable 

supplied with MobIR M series camera. 
 TP8 Device 
After installing the USB driver and connecting TP8 camera to your PC, choosing this 
command will open a dialog box below for you to download some files to PC or delete all 
the image files.  

 
File Transfer  
Get file from……to: Appoint the file range as per file numbers which will be transferred to 
PC. 
PC store directory: Appoint store directory for the files in PC. 
Click button Read to transfer files to PC. Or Clicking button Delete ALL will eliminate all 
the image files from the built-in flash memory of TP8 camera. Click button Close can exit 
the command.  
Exit Command 
Use this command to end your Guide IrAnalyser® session. After choosing this command, 
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the program will prompt you to save image files with unsaved changes. 
Image Menu 
The Image menu offers the following commands: 
Palette Choose palettes for an opening image file 
Rotate Rotate an opening image file clockwise or counterclockwise  
Mirror Display horizontal and vertical mirror images of an opening image 

file 
Zoom  Zoom out an opening image by 50% or keep original size or zoom in 

an opening image by 150%, 200%, 300%, 400%, 500% or 
self-define zoom in multiple.  

Zoom In  Zoom in an opening image  
Zoom Out  Zoom out an opening image  
Hand  Move the scroll bars around an opening image file to view the 

desired parts of the file 
Actual Size Resume the original size of an opening image file window  
Gauge Setting  Change temperature range to adjust brightness of an opening image 

file by moving the two slides  
Gauge Advance 
Setting 

Change temperature range to adjust brightness of an opening image 
file by changing the max and min temperature  

Image Fusion Set the infrared image and visual image in fusion 
Play Sound Play voice annotation saved with an opening image file if any 
Property  Display the property of an opening image file 
 
Palette Command 
Use this command to choose a palette from the nine available for the current opening 
image file. 

  
Note:  
 Using palette bar can activate this function as well. Please refer to Palette Bar.   

 
Rotate Command 
This command contains two sub-commands as follows: 
90 CCW: Use this command to rotate the current opening image file 90 degrees 
counterclockwise 
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90 CW: Use this command to rotate the current opening image file 90 degrees clockwise 

                    
  
 Mirror 

Command 
This command includes two sub-commands as follows: 

Horizontal: Use this command to get horizontal mirror image of the current opening 
image file 

   
Vertical: 
Use this command to get vertical mirror image of the current opening image file 
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Zoom Command  
For TP8: All images opened by analysis software have been zoomed in by 150% based 
on its original size captured by TP8 camera.  
For M Series camera: All images opened by analysis software have been zoomed in by 
200% based on its original size captured by MobIR M series camera. 
For IR928 Series Camera: All images opened by analysis software is in the same size 
with that captured by IR928 series camera  
 
This command contains eight sub-commands as follows: 
50%: Use this command to zoom out an opening image by 50% based on original image 
size.  
100%: Use this command to restore original size of an opening image   
150%: Use this command to zoom in an opening image by 150% based on original image 
size. 
200%: Use this command to zoom in an opening image by 200% based on original image 
size. 
300%: Use this command to zoom in an opening image by 300% based on original image 
size. 
400%: Use this command to zoom in an opening image by 400% based on original image 
size. 
500%: Use this command to zoom in an opening image by 500% based on original image 
size. 
Custom: User this command to self-define multiple based on original image size.  

 
 
Zoom In Command 
Zoom in an opening image by 100%→150%→200%→300%→400%→500%......→1000%   

Click the shortcut of  can activate this command as well 

Zoom Out Command  
Zoom out an opening image by 150%→100%→50% based on 150% zoomed in image.  
Restore zoomed in image in opposite sequence when zooming in image: 
1000%→900%→800%.......→50%.  

Click the command of  can activate this command as well 

Hand  
Move the scroll bars around an opening image file to view the desired parts of the file 
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Set Cursor  
Change the mouse shape to be an arrow or a cross-line  
Small: Choose this command to change the mouse to be an arrow  
Large: Choosing this command will change the mouse to be a cross-line. The cross-line is 
originally as large as a pixel and will change as the image file size changes.  
 
Actual Size Command  
The mouse pointer becomes a two-headed arrow keys when you move it to the frames of 
an opening image file window. Move the two-headed arrow keys can zoom in or out the 
file window. Use this command will restore the original size of the file window.  
 
Gauge Setting Command  
The program establishes a mapping function for temperature and brightness of each 
image file. This command utilizes this mapping function to adjust brightness of the current 
opening image file. Dialog box of Temp Range will appear after choosing this command.  

 

Moving the scale pointer to select a suitable temperature range and then double click the 
opening image will confirm the change. Or click button Auto to restore the original 
brightness. Click button Cancel to ignore the modification. If selecting Preview, the 
modification will display on image immediately.  
 
Note:  
 Double clicking the opening image file will activate this command as well. 
 It could not change the pallet when you adjust the gauge scale 

 
Gauge Advance Setting Command 
The program establishes a mapping function for temperature and brightness of each 
image file. This command utilizes this mapping function to adjust brightness of the current 
opening image file. Dialog box of gauge advance setting will appear after choosing this 
command.  

 
Type in the max and min temperature (any temperature in whole temperature range) and 
click Apply to change the mapping function and adjust brightness of current opening 
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image file.  
If multi images are opened, Selecting Apply to all image will apply the temperature setting 
to all opening image file.  
The command is useful if operator wants to compare similar thermal images. Operator just 
sets a temperature range and applies to all the images, then, the difference between each 
image is easily found.  
 
Play Sound Command 
Use this command to play voice annotation saved with the current opening image file if 
any. 
Note:  
 This command is only available for files with voice annotation stored.  
 Clicking shortcut  in the toolbar will activate this command as well. The shortcut is 

only available for files with voice annotation stored. 
 
Property Command 
Use this command to display property of the current opening image file. Click button OK 
will save the words which you write in the Remark 

 
Note:  
 Filter: It reflects the filter of the camera which you choose to take the infrared image. It 

also could reflect camera lens if it is used additional lense.     
 Emissivity: It reflect the object emissivity which you set in the infrared camera. If you 

change it here, the image temperature would be also changed. 
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Filter Menu  

The Filters menu offers the following commands: 

Blur  Get fuzzy effect of image  

Emboss  Get emboss effect of image  

Gaussian  Get smooth image  

Soften  Get soft image  

Sharpen  Get sharp image  

Edge  Get image edge intensified  

Median  Get the image median filtered, let it become 
soft  

Add Noise  Add noise to image  

Erode  Get erosive effect of image 

Dilate  Get inflated effect of image 

Contour  Display image contour  

Jitter  Get agitating effect of image 

 

Blur 

             

Emboss  

                 

 

Gaussian  
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Measure Menu  
The Measure menu offers the following commands: 
Temp Unit Choose degrees Celsius or degrees Fahrenheit for temperature 

reading of an opening image file  
Show MaxTemp Pos Indicate where the pixel with the Max temperature lies in an 

opening image file  
Show Min Temp Pos Indicate where the pixel with the Min temperature lies in an 

opening image file 
Show Profile Display temperature profile of lines added to an opening image 

file (if any) 
Isotherm Add an isotherm to an opening image file for analysis 
Histogram Image Histogram: Display the temperature distribution histogram 

of an opening image file 
Other Histogram: Display the temperature distribution histogram 
of an object (a line, rectangle, circle or polygon) added to the 
opening image file (if any)  

Add Spot Add a spot to an opening image file for temperature 
measurement  

Add Line Add a line to an opening image file for temperature measurement 
Add Polygon line Add a polygon line to an opening image file for temperature 

measurement 
Add Rectangle Add a rectangle to an opening image file for temperature 

measurement 
Add Circle Add a circle to an opening image file for temperature 

measurement 
Add Polygon  Add a polygon to an opening image file for temperature 

measurement 
Add Delta Two  Add a pair of spots to an opening image file for temperature 

measurement 
Combination Create combined object based on existing area objects for 

temperature measurement 
Delete Object Delete an object (a spot, line, rectangle, circle, polygon or a pair 

of delta-two spots )added to an opening image file (if any) 
Delete All Objects Delete all the objects (spots, lines, rectangles, circles, polygons 

or delta-two spots) added to an opening image file (if any) 
 
Temp Unit Command 
Use this command to choose one from the two degrees Celsius and Fahrenheit for 
temperature reading of the current opening image file.  
Note:  
 You can switch between the two degrees as per requirements. 
 All the temperature reading of the image file will change accordingly with your choice.  
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Show Max/Min Temp Pos Command  
Use this command to indicate location of the point that has the max/min temperature of an 
opening image file by using the symbol and Max/Min  
After choosing this command, the symbol and Max/Min will appear immediately in the 
image file to indicate where the point is.  

 
Note:  
Max/Min Temp point along with temperature value will be on the image automatically 
when you open the image. Choose this command again to delete the Max/Min Temp point 
on the image.  
 
Show Profile Command  
Use this command to display temperature profiles of lines added to an opening image file.  
Click this command will display the Profile View window. Line profiles are displayed in the 
rectangular coordinates. When moving the mouse along the profiles, a vertical line will 
appear and move together with the mouse, showing temperature of the point where the 
vertical line intersects the profiles. Icon + will show corresponding point on the line.  

 

 
Clicking the right button of mouse on the line profile view window will bring up four 
commands for it, Copy, Setting, Save as, and Close 
Choosing command Copy allows you to copy the rectangular coordinates and lines 
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profiles to other applications.  
Choosing command Setting enables you to bring up the setup dialog box and change 
colors and the background of the rectangular coordinates if you wish. Click Button OK to 
save changes and Button Cancel to cancel. 

 
 
Choosing command Save As will allow you to save the rectangular coordinates and lines 
profiles to be BMP or JPG image file.  
Clicking button Close will close the profile view window.  
Note:  
 Temperature reading and unit of the coordinates will change with your choice of 

temperature degrees.   

 Clicking short button  in the toolbar can activate this command as well.  

 
Isotherm Command 
Use this command to add an isotherm to an opening image file for 
analysis.  
The dialog box Isotherm setting will appear after choosing this command.  

Clicking Button  brings up the default isotherm, with its name, color 

and location in the temperature range displayed as well. Click on its name, 
its upper and lower limits will be displayed with both numbers and pointers 
on temperature scales. You can change its color, and limits by moving the 
scale pointers.  

Clicking Button  again and repeating the above will add new 

isotherms and make changes to them as per requirements.   
Then pixels of the image file within the isotherm ranges are displayed in the isotherm 
colors.  

Choosing an isotherm name and clicking button  will delete the isotherm.  

 
Histogram Command 
This command includes two sub-commands as follows: 
Image Histogram: Use this command to display the temperature distribution histogram of 
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an opening image file.  

 

 
Other Histogram: Use this command to display the temperature distribution histogram of 
an analysis object (a line, polygon line, rectangle, circle or polygon) added to the opening 
image file (if any) 
 
♦ Image Histogram 

 After choosing this command, a dialog box showing the histogram in the rectangular 
coordinates appears.   

 While moving the mouse within in the rectangular coordinates, temperature range 
and percent of the bar (histogram consists of multiple bars) where the mouse points 
at appears. 

 Clicking the right button of mouse on the dialog box 
will bring up four commands for it, Copy, Setting, 
Save as, and Close. 

 Choosing command Copy allows you to copy the 
rectangular coordinates and the histogram to other 
applications.  

 Choosing command Setting enables you to bring up the setup dialog box and change 
colors and background of the rectangular coordinates if you wish. Click Button OK to 
save and Button Cancel to cancel changes.  

 Choosing command Save As will allow you to save the 
rectangular coordinates and histogram to be BMP or 
JPG image file.  

 Clicking button Close will close the dialog box.  
♦ Other Histogram 

 After adding an object (a line, rectangle, circle or 
polygon) to the opening image file, choosing this 
command will open a dialog box showing the object name and type. 
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 Click on the object, and then click button View, the histogram of the object will be 
displayed.  

 While moving the mouse within the rectangular coordinates, temperature range and 
percent of the bar where the mouse points at appears. 

 
 Clicking the right button of mouse on the dialog box will bring up four commands for it, 

Copy, Setting, Save as, and Close. 
 Choosing command Copy allows you to copy the rectangular coordinates and the 

histogram to other applications.  
 Choosing command Setting enables you to bring up the setup dialog box, change 

colors and background of the rectangular coordinates if you wish. Click Button OK to 
save and Button Cancel to cancel changes.  

 Choosing command Save As will allow you to save the rectangular coordinates and 
histogram to be BMP or JPG image file.  

 Clicking button Close will close the dialog box.  
Note:  

 Clicking short button  in the toolbar can activate command Image Histogram.  

 Viewing histograms of spots and delta-two spots added to an opening file (if any) is not 
available.  

 
Add Spot Command 
Use this command to add a spot to an opening image file for temperature measurement.  
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After choosing this command, clicking left button of the mouse within an opening image 
file will add a spot to it, with temperature of the spot and its number shown beside it and 
also in DataView Bar. 

 
You can change position and property of a spot added to the opening image file as 
follows:  
♦ Move the spot: 

 Move the mouse to the spot (more accurately to the symbol ), the mouse pointer 

will change to be a four-headed arrow with a symbol +. Clicking the left button of the 

mouse to select it, there will be four small squares around the spot , indicating the 
spot is moveable at present. To move the spot, keep left button of the mouse 
depressed and drag the mouse to any desired place, then release the left button to 
confirm the place.    

♦ Modify the spot property:  

 Move the mouse to the spot (more accurately to the symbol ),  the mouse pointer 

will change to be a four-headed arrow with a symbol +, indicating you can select the 
spot and modify its property at present. Double click the spot to open dialog box Spot 
Property. Then you can modify the items within to modify the spot property. 

 

 Moving the pointer on transparency scale will allow the spot symbol  to change 
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from being completely transparent to being completely solid. Selecting Show 
Temperature will display temperature of the spot within the image file window. 
Choosing Custom and changing emissivity value will make the program to recalculate 
and display temperature of the spot accordingly.  

 After such modification, clicking button OK will save or clicking button Cancel will give 
up the modification.  

Note:  

 Clicking shortcut  in the toolbar will activate this command as well.  

 
Add Line Command  
Use this command to add a line to an opening image file for temperature measurement.  
After choosing this command, keeping left button of the mouse depressed and dragging 
the mouse within an opening image file will add a line to it, with Average, Max and Min 
temperature of the line shown in DataView Bar. Number and average temperature will 
show beside the mouse when it moves along the line.  
You can change position, size and property of a line added to the opening image file as 

follows: 

 
♦ Move the line: 

 Move the mouse to the line (between its starting point and ending point), the mouse 
pointer will change to be a four-headed arrow with a symbol -. Clicking the left button 
of mouse to select it, there will be two small squares at its two ends, indicating the 
line can be moved now. To move the line, keep left button of the mouse depressed 
and drag the mouse to any desired place, then release the left button to confirm the 
place. 

 
♦ Change the line size:  

 Click left button of the mouse on the line to select it and move the mouse to either end 
of the line, the mouse pointer will change to be a two-headed arrow, indicating you 
can change the line size with the arrow keys. Place the mouse on one end of the line, 
keep left button of the mouse depressed and drag the mouse to a desired place, then 
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release the left button to confirm the new place of this end. Now the line size is 
changed. You can change the other end in the same way if needed.  

 
♦ Modify the line property: 

 Place the mouse on the line and then double click left button of the mouse to get 
dialog box Line Property. Now you can modify the property by changing items in the 
dialog box, such as name, color, emissivity, and etc.  

 

 Moving the pointer on transparency scale allows the line to change from being 
completely transparent to being completely solid. Selecting Show min/ max position 
can indicate where the spot having min/ max temperature of the line lies, with symbol 
×/* shown on the line. Choosing Custom and changing emissivity value makes the 
program to recalculate and display temperature of the line accordingly. Selecting 
Show temperature on image and then choosing any sub-option will allow the program 
to display Average, Max or Min temperature of the line.  

 After such modification, click button OK to save or click button Cancel to cancel the 
modification.  

Note:  

 Clicking shortcut  in the toolbar will activate this command as well.  

   
Add Polygon Line Command  
Use this command to add a polygon line to an opening image file for temperature 
measurement.  
After choosing this command, drag the mouse and click the left button of the mouse 
continuously to confirm the turning points, connect the spots and double click the left 
bottom of the mouse, a Polygon Line will be added to the image, with Average, Max and 
Min temperature of the polygon line shown in DataView Bar. Number and average 
temperature will show beside the mouse when it moves along the polygon line.  
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You can change position, size and property of a Polygon line added to the opening image 
file as follows:  
♦ Move the polygon line:  

 Move the mouse to the polygon line (between its starting point and ending point), the 
mouse pointer will change to be a four-headed arrow with a symbol -. Clicking the left 
button of mouse to select it, there will be small squares at its two ends and the turning 
points, indicating the polygon line can be moved now. To move the polygon line, keep 
left button of the mouse depressed and drag the mouse to any desired place, then 
release the left button to confirm the place. 

♦ Change the polygon line size: 
 Click left button of the mouse on the line to select it and move the mouse to either 

turning points of the polygon line, the mouse pointer will change to be a two-headed 
arrow, indicating you can change the polygon line size with the arrow keys. Place the 
mouse on one turning point of the line, keep left button of the mouse depressed and 
drag the mouse to a desired place, then release the left button to confirm the new 
place of the turning point. Now the turning point position is changed. You can change 
either turning points including the beginning point and ending point in the same way if 
needed.  

♦ Modify the polygon line property: 
 Place the mouse on the polygon line and then double click left button of the mouse to 

get dialog box Line Property. Now you can modify the property by changing items in 
the dialog box, such as name, color, emissivity, and etc.  
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 Moving the pointer on transparency scale allows the polygon line to change from 

being completely transparent to being completely solid. Selecting Show min/ max 
position can indicate where the spot having min/ max temperature of the polygon line 
lies, with symbol ×/* shown on the polygon line. Choosing Custom and changing 
emissivity value makes the program to recalculate and display temperature of the 
polygon line accordingly. Selecting Show temperature on image and then choosing 
any sub-option will allow the program to display Average, Max or Min temperature of 
the polygon line. Selecting color to set the color of polygon line to be displayed in 

 After such modification, click button OK to save or click button Cancel to cancel the 
modification.  

Note:  

 Clicking shortcut  in the toolbar will activate this command as well.  
 
 
Add Rectangle Command  
Use this command to add a rectangle to an opening image file for temperature 
measurement. 
After choosing this command, keeping left button of the mouse depressed and dragging 
the mouse within an opening image file will draw a rectangle in it. Release the left button, 
the rectangle will be confirmed, with Average, Max and Min temperature within it shown in 
DataView Bar. Number and average temperature of the rectangle will show beside the 
mouse when it moves in the rectangle.  



User Manual                                                                    

 
You can change position, size and property of a rectangle added to the opening image file 
as follows:  
♦ Move the rectangle: 

 Move the mouse into the rectangle, the mouse pointer will change to be a four-headed 
arrow with a symbol □. Clicking the left button of mouse to select it, there will be eight 
small squares on its sides and vertexes, the rectangle can be moved now. To move 
the rectangle, keep left button of the mouse depressed and drag the mouse to a 
desired place, then release the left button to confirm the place. 

♦ Change the rectangle size: 
 Click left button of the mouse in the rectangle to select it first and move the mouse to 

any one side of the rectangle or any one of its vertexes, the mouse pointer will 
change to be a two-headed arrow, indicating you can change the rectangle size with 
the arrow keys. Place the mouse on one side of the rectangle or any one of its 
apexes, keep left button of the mouse depressed and drag the mouse to a desired 
place, then release the left button to confirm the new place of this side. Now the 
rectangle size is changed. You can move other three sides in the same way if 
needed.  

♦ Modify the rectangle property: 
 Place the mouse within the rectangle and then double click left button of the mouse to 

get dialog box Rectangle Property. Now you can modify the property by changing 
items within, such as name, color, emissivity, and etc.   
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 Moving the pointer on transparency scale allows four sides of the rectangle to change 
from being completely transparent to being completely solid. Choosing Custom and 
then changing emissivity value makes the program to accordingly recalculate and 
display temperature within the rectangle. Selecting Show min/ max position allows 
the program to use symbol ×/* to indicate position of the spot having min/ max 
temperature within the rectangle. Selecting Show temperature on image and then 
choosing any sub-option will allow the program to display Average, Max or Min 
temperature within the rectangle.  

 After such modification, click button OK to save or button Cancel to give up the 
modification. Picture on the right shows the rectangle with property modified. 

Note:  

 Clicking shortcut  in the toolbar will activate this command as well.  

 
Add Circle Command 
Use this command to add a circle to an opening image file for temperature measurement. 
After choosing this command, keeping left button of the mouse depressed and dragging 
the mouse within an opening image file will draw a circle in it. Release the left button, the 
circle will be confirmed, with Average, Max and Min temperature within it shown in 
DataView Bar. Number and average temperature will show beside the mouse when it 
moves in the circle.  
You can change position, size and property of a circle added to the opening image file as 
follows: 

 

♦ Move the circle: 
 Move the mouse into the circle, the mouse pointer will change to be a four-headed 

arrow with a symbol o. Clicking the left button of mouse to select it, there will be eight 
small squares on its frame, indicating the circle can be moved now. To move the 
circle, keep left button of the mouse depressed and drag the mouse to a desired 
place, then release the left button to confirm the place. 

♦ Change the circle size: 
 Click left button of the mouse in the circle to select it and move the mouse to any one 
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of the eight small squares, the mouse pointer will change to be a two-headed arrow, 
indicating you can change the circle size with the arrow keys. Place the mouse on the 
circle frame, keep left button of the mouse depressed and drag the mouse to a 
desired place, then release the left button to confirm the new place. Now the circle 
size is changed.  

♦ Modify the circle property: 
 Place the mouse within the circle and then double click left button of the mouse to get 

dialog box Circle Property. Now you can modify the property by changing items within, 
such as name, color, emissivity, and etc. 

 
 Moving the pointer on transparency scale allows the circle frame to change from being 

completely transparent to being completely solid. Choosing Custom and then 
changing emissivity value makes the program to accordingly recalculate and display 
temperature within the circle. Selecting Show min/ max position allows the program 
to use symbol ×/* to indicate position of the spot having min/ max temperature within 
the circle. Selecting Show temperature on image and then choosing any sub-option 
will allow the program to display Average, Max or Min temperature within the circle.  

 After such modification, click button OK to save or button Cancel to give up the 
modification.  

Note:  

 Clicking shortcut  in the toolbar will activate this command as well.  

 
Add Polygon Command 
Use this command to add a polygon to an opening image file for temperature 
measurement. 
After choosing this command, keep left button of the mouse depressed, drag the mouse 
within an opening image file and then release the left button to draw the first side of a 
polygon. Then keep the left button depressed on the ending point of this side and drag the 
mouse again to draw the other two sides of the polygon. Repeat the above to draw some 
more sides of the polygon. Release the left button and double click on the last vertex of 
the polygon, the polygon will be confirmed, with Average, Max and Min temperature within 
it shown in DataView Bar. Number and average temperature will show beside the mouse 
when it moves in the polygon.  
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You can change position, size and property of a polygon added to the opening image file 
as follows:  
♦ Move the polygon: 

 Move the mouse into the polygon, the mouse pointer will change to be a four-headed 

arrow with a symbol . Clicking the left button of mouse to select it, there will be a 

small square on every vertex, indicating the polygon can be moved now. To move the 
polygon, keep left button of the mouse depressed and drag the mouse to any desired 
place, then release the left button to confirm the place. 

♦ Change the polygon size:   
 Click left button of mouse in the polygon to select it and move the mouse to any one 

vertex of the polygon, the mouse pointer will change to be a two-headed arrow, 
indicating you can change the polygon size with the arrow keys. Place the mouse on 
the vertex, keep left button of the mouse depressed and drag the mouse to a desired 
place, then release the left button to confirm the new place of the vertex. Repeat the 
above to move some more vertexes of the polygon if needed. Then the polygon size 
is changed.   

♦ Modify the polygon property:  
 Place the mouse within the polygon and then double click left button of the mouse to 

get dialog box Polygon Property. Now you can modify the property by changing items 
in the dialog box, such as name, color, emissivity, and etc. 
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 Moving the pointer on transparency scale allows four sides of the polygon to change 
from being completely transparent to being completely solid. Choosing Custom and 
then changing emissivity value makes the program to accordingly recalculate and 
display temperature within the polygon. Selecting Show min/ max position allows the 
program to use symbol ×/* to indicate position of the spot having min/ max 
temperature within the polygon. Selecting Show temperature on image and then 
choosing any sub-option will allow the program to display Average, Max or Min 
temperature within the polygon.  

 After modification, click button OK to save or button Cancel to give up it. 
Note:  

 Clicking shortcut  in the toolbar will activate this command as well.  

 
Add Delta Two Command  
Use this command to add a pair of spots to an opening image file for Delta Two 
temperature measurement. 
After choosing this command, keep left button of the mouse depressed, drag the mouse 
within an opening image file and then release the left button, a pair of spots and the 
broken line between them will be confirmed. Two symbol x indicate the two spots. 
Temperature of the two spots, delta temperature and temperature ratio list in DataView 
Bar.  

 

You can change position, size of the broken line and property of the pair of spots as 
follows:  
♦ Change location: 

 Move the mouse to either of the two spots (i.e. one end of the broken line between 
them), the mouse pointer will change to be a four-headed arrow. Click left button of 
the mouse on either of the two spots to select it and then move the mouse to either 
spot of the two, the mouse pointer will change to be a two-headed arrow, indicating 
the spot can be moved now. To move it, keep left button of the mouse depressed and 
drag the mouse to a desired place, then release the left button to confirm the place. 

♦ Change size:  
 Move the mouse to either spot of the two (i.e. one end of the broken line between 
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them), the mouse pointer will change to be a four-headed arrow. Click left button of 
the mouse on either spot of the two to select it and move the mouse to either spot of 
the two, the mouse pointer will change to be a two-headed arrow, indicating you can 
change the broken line size with the arrow keys. Place the mouse on the spot, keep 
left button of the mouse depressed and drag the mouse to a desired place, then 
release the left button to confirm the new place of this spot. Now size of the broken 
line is changed. You can move the other spot in the same way if needed.  

♦ Modify property: 
 Place the mouse on either spot of the two and then double click left button of the 

mouse to get dialog box DeltaTwo Property. Now you can modify the property by 
changing items within, such as name, color, emissivity, and etc.  

 

 Moving the pointer on transparency scale allows the two spots and the broken line 
between them to change from being completely transparent to being completely solid. 
Choosing Custom and changing emissivity value makes the program to recalculate 
and display temperature of the two spots accordingly.  

 After modification, click button OK to save or button Cancel to cancel it.  
 

Add Combination Command 
Use this command to combine two areas to create a new object via set operation. 
Combination command contains five sub-commands as following 
Intersection Command 
Add two areas(like rectangle, circle, polygon) in the thermal image file and confirm one of 
them by clicking the left bottom of mouse, select the command of Intersection under 
Combination and move the mouse to another area, click the left bottom of mouse again to 
bring out a intersection of two areas for temperature measurement.  
 

                  
Average, Max and Min temperature of the intersection object will be shown in DataView 
Bar. Number and average temperature will be shown beside the mouse when it moves in 
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the intersection area.  
You can change position, size and property of the intersection object added to the 
opening image file as follows:  
♦ Move the intersection object: 

 Move the mouse into the intersection area, the mouse pointer will change to be a 
four-headed arrow with a symbol o. Keep left button of the mouse depressed and 
drag the mouse to a desired place, then release the left button to confirm the place. 

♦ Modify the intersection object property: 
 Place the mouse within the intersection object and then double click left button of the 

mouse to get dialog box Polygon Property. Now you can modify the property by 
changing items within, such as name, color, emissivity, and etc.    

 

 Moving the pointer on transparency scale allows the intersection frame to change from 
being completely transparent to being completely solid. Choosing Custom and then 
changing emissivity value makes the program to accordingly recalculate and display 
temperature within the intersection object. Selecting Show min/ max position allows 
the program to use symbol ×/* to indicate position of the spot having min/ max 
temperature within the intersection. Selecting Show temperature on image and then 
choosing any sub-option will allow the program to display Average, Max or Min 
temperature of the intersection object. Change color to set the color of the 
intersection object to be displayed in.  

 After such modification, click button OK to save or button Cancel to give up the 
modification.  

 
Subtract Command 
Add two areas(like rectangle, circle, polygon) in the thermal image file and confirm one of 
them by clicking the left bottom of mouse, select the command of Subtract under 
Combination and move the mouse to another area, click the left bottom of mouse again to 
confirm the subtract of two areas for temperature measurement.  
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Average, Max and Min temperature of the intersection object will be shown in DataView 
Bar. Number and average temperature will be shown beside the mouse when it moves in 
the subtract area.  
You can change position, size and property of the intersection object added to the 
opening image file as follows:  
♦ Move the subtract object: 

 Move the mouse into the subtract area, the mouse pointer will change to be a 
four-headed arrow with a symbol o. Keep left button of the mouse depressed and 
drag the mouse to a desired place, then release the left button to confirm the place. 

♦ Modify the subtract object property: 
 Place the mouse within the intersection area and then double click left button of the 

mouse to get dialog box Polygon Property. Now you can modify the property by 
changing items within, such as name, color, emissivity, and etc.    

 
 Moving the pointer on transparency scale allows the intersection frame to change from 

being completely transparent to being completely solid. Choosing Custom and then 
changing emissivity value makes the program to accordingly recalculate and display 
temperature within the subtract area. Selecting Show min/ max position allows the 
program to use symbol ×/* to indicate position of the spot having min/ max 
temperature within the subtract. Selecting Show temperature on image and then 
choosing any sub-option will allow the program to display Average, Max or Min 
temperature of the subtract object. Change color to set the color of the subtract object 
to be displayed in.  

 After such modification, click button OK to save or button Cancel to give up the 
modification.  

 
Merge Command 
Add two areas(like rectangle, circle, polygon) in the thermal image file and confirm one of 
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them by clicking the left bottom of mouse, select the command of Merge under 
Combination and move the mouse to another area, click the left bottom of mouse again to 
confirm the merge of two areas for temperature measurement.  
 

             
Average, Max and Min temperature of the Merge object will be shown in DataView Bar. 
Number and average temperature will be shown beside the mouse when it moves in the 
merge.  
You can change position, size and property of the merge object added to the opening 
image file as follows:  
♦ Move the merge object: 

 Move the mouse into the merge area, the mouse pointer will change to be a 
four-headed arrow with a symbol o. Keep left button of the mouse depressed and 
drag the mouse to a desired place, then release the left button to confirm the place. 

♦ Modify the merge object property: 
 Place the mouse within the merge area and then double click left button of the mouse 

to get dialog box Polygon Property. Now you can modify the property by changing 
items within, such as name, color, emissivity, and etc.    

 
 Moving the pointer on transparency scale allows the merge frame to change from 

being completely transparent to being completely solid. Choosing Custom and then 
changing emissivity value makes the program to accordingly recalculate and display 
temperature within the merge. Selecting Show min/ max position allows the program 
to use symbol ×/* to indicate position of the spot having min/ max temperature within 
the merge area. Selecting Show temperature on image and then choosing any 
sub-option will allow the program to display Average, Max or Min temperature of the 
merge object. Change color to set the color of the merge to be displayed in.  

 After such modification, click button OK to save or button Cancel to give up the 
modification.  
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Not Overlap Command 
Add two areas(like rectangle, circle, polygon) in the thermal image file and confirm one of 
them by clicking the left bottom of mouse, select the command of Not Overlap under 
Combination and move the mouse to another area, click the left bottom of mouse again to 
confirm the not overlap part of two areas for temperature measurement.  
 

             
Average, Max and Min temperature within the not overlap area will be shown in DataView 
Bar. Number and average temperature will be shown beside the mouse when it moves in 
the not overlap area.  
You can change position, size and property of the not overlap area added to the opening 
image file as follows:  
♦ Move the not overlap area: 

 Move the mouse into the overlap area, the mouse pointer will change to be a 
four-headed arrow with a symbol o. Keep left button of the mouse depressed and 
drag the mouse to a desired place, then release the left button to confirm the place. 

♦ Modify the not overlap area property: 
 Place the mouse within the not overlap area and then double click left button of the 

mouse to get dialog box Polygon Property. Now you can modify the property by 
changing items within, such as name, color, emissivity, and etc.    

 
 Moving the pointer on transparency scale allows the merge frame to change from 

being completely transparent to being completely solid. Choosing Custom and then 
changing emissivity value makes the program to accordingly recalculate and display 
temperature within the not overlap area. Selecting Show min/ max position allows the 
program to use symbol ×/* to indicate position of the spot having min/ max 
temperature within the not overlap area. Selecting Show temperature on image and 
then choosing any sub-option will allow the program to display Average, Max or Min 
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temperature within the not overlap area. Change color to set the color of the not 
overlap area to be displayed in.  

 After such modification, click button OK to save or button Cancel to give up the 
modification.  

 
Decompose Command  
Select the combination object and activate Decompose under Combination to decompose 
the combination  
Example: 
I After Decompose Command, R1 is decomposed into RT1 and A1. 
Image below shows a combined object created by RT1 and A1 via Not overlap operation. 

                  

 
Delete Object Command  
Use this command to delete an object (a spot, line, rectangle, 
circle, polygon or a pair of delta-two spots) added to an opening 
image file if any.  
After choosing this command, move the mouse into the opening 
image file, then the mouse pointer will change to be a ×, indicating 
you can delete any object you want to delete.  
To delete a spot, line, rectangle, circle or polygon, move the mouse to it and click left 
button of the mouse, then you will delete it.   
To delete a pair of delta-two spots, move the mouse to either of the spots (i.e. either end of 
the broken line) and click left button of the mouse, then you can delete them. 
Note:  

 Clicking shortcut  in the toolbar will activate this command as well. 

 The shape of mouse pointer varies from different objects to be deleted.  
 This is no available to the Max Temp point created automatically with the open image. 

 
Delete All Objects Command  
Use this command to delete all the objects (spots, lines, polygon lines, rectangles, circles, 
polygons and delta-two spots) added to an opening image file if any.  
After choosing this command, all the objects will be erased from the opening image file.   
Note:  
 This is no available to the Max Temp point created automatically with the open image. 
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Tools Menu  
Multi-isotherm.  
It contains two sub-commands: Setting and Apply. Using this command can divide the 
temperature range within an opening image into some small temperature ranges. 
Difference temperature range can be differently colorized. It is easy to see temperature 
distribution as per color.  
Setting:To divide temperature ranges within the whole thermal image. It can be done both 
manually and automatically. After carrying out this command, the window below will come 
out:  

 
Add: to add a temperature range. After carrying out this command, a line will be added, 
you can select color and set min temperature and max temperature as follows:  
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Delete: Delete one temperature range.  
Auto Build: Type in min and max temperature, set number of temperature range in Single 
Spacing and click Build will averagely divide whole temperature range and build certain 
numbers of temperature ranges.  

   
Save: Save divided the temperature ranges for future use. Click Save, the setting will be 
applied. The infrared image will be displayed as per the setting.  
Apply:Apply or cancel self-define colorization for the opening image.  
 
Image chart 
This function is used to analyze the trend of highest and lowest temperature in multi 
images. It could not only analyze the highest and lowest temperature of each whole image, 
but also could analyze the highest and lowest temperature of the analysis target. There 
are two ways of displaying trend: 1,diagram; 2, data. 
When you open multiple images, click the Tool->Image chart, you will see the below dialog 
box 
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The check box below the “Select Image” means to choose open selected images. The 
check box below “Select Analyse Objects” means to choose analysis target, such as the 
Maximum spot, Minimum spot or others. 
Open File: It is used to open“*.ird”file which you would save after you do multiple images 
analysis.   
Add Image: It is used to add images into the “Select Image” below. 
Open Image: It is used to set the chosen image as current window 
Save Image: It is used to save multiple images analysis into“*.ird” file. 
Built Chart: Click it and then it will generate dialog box as follows: 

 
 
Here is the instruction of the tools bar  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Save  Copy 

Print Exit 

Line 

Vertical histogram 
Horizontal histogram 

Area 

Point 
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The meaning of above icons are as they showed: zoom in, zoom out, reset zoom, left shift, 
up shift, down shift, right shift. 
 

 
When you click the icon of 3D, the chart is displayed in three dimensional and it is also 
could rotate. 
 

 

The above tool bar is to choose analysis target and color. 
 

 

The above tool bar is to display data point and mark style. 

 

Auto scale: It is showed the range of Axis Y. If click the check box it will run auto range, if 
not click the check box you could set the Max and Min manually. 
 

 

Show scroll: It is displayed point number of the curve, if choose it you could set the length 
of X Axis 
 

 

Title: you could type the title name on the blanket 
 
 
View Menu  
 
The View menu offers the following commands: 
Show visual Image Show or hide the visual image  
Toolbar Show or hide the Toolbar. 
Gauge Bar  Show or hide the gauge bar  
Status Bar Show or hide the Status Bar. 
Palette Bar Show or hide the Palette Bar. 
DataView Bar Show or hide the DataView Bar. 
Information Bar Show or hide the Information Bar. 
Language Select one language from Default, English and Simplified 

Chinese to be the language the program uses 
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Show visual image 
Use this command to display and hide the visual image, you could see the thermal image 
only if you set hiding the visual image. 
 
 
Toolbar Command 
Use this command to display and hide the toolbar, which provides shortcuts to major 
functions in the program. A checkmark appears next to the sub-menu Toolbar when the 
toolbar is displayed.  
Shortcut Description 

 
Open Image Button 

 Save Image Button 

 Select Button 

 Add Spot Button 

 
Add Line Button 

 Add Polygon Line Button 

 
Add Rectangle Button 

 Add Circle Button  

 
Add Polygon Button  

 Add Delta-two Spots Button 

 Delete Object Button 

 Hand Button 

 
Zoom In Button  

 
Zoom Out Button  

 
Show Histogram Button 

 Show Profile Button 

 Play Sound Button 

 
Palette Bar Button 

 About IrAnalyser Button 

 
Specific Help Button 
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Note:  
 You can refer to commands under menu bar to find detailed information of the 

shortcuts. 
 Specific Help Button means you can use this shortcut to get help for a specific menu 

item or toolbar button within the program. Choosing this shortcut and clicking a menu 
item or toolbar button you want to know more about will make the program to display 
the help content relevant to the object.      

 
Gauge Bar Command  
Use this command to display and hide gauge bar. A checkmark appears next to the 
sub-menu Gauge Bar when the gauge bar is displayed. 
 
Status Bar Command 
Use this command to display and hide the status bar, which describes the action to be 
executed by the selected menu item or pressed toolbar button. A checkmark appears next 
to the sub-menu Status Bar when the status bar is displayed. 
 
Palette Bar Command 
Use this command to display and hide the palette bar. A checkmark appears next to the 
sub-menu Palette Bar when the palette bar is displayed. 
 
DataView Bar Command 
Use this command to display and hide the DataView bar. A checkmark appears next to 
the sub-menu DataView Bar when the dataview bar is displayed. 
 
Information Bar Command 
Use this command to display and hide the information bar. A checkmark appears next to 
the sub-menu Information Bar when the information bar is displayed. 
 
Language Command 
Use this command to choose one language from Default, Several languages such as 
English ,Simplified Chinese, Traditional Chinese, France and so on is selectable for the 
program uses. A checkmark appears next to the sub-option whichever is chosen.  
Note:  
 Default is the default language of the operating system in your PC. If the program 

cannot recognize the language, the program will choose English to be the default.   
 After you change the language, a dialog box will prompt you to restart the program so 

as to effect the change. Clicking button Yes will close down, restart the program and 
change its language to be the one you chose. Clicking button No will remain the 
language before choice. Then language change will not be effected until you restart 
the program next time.  

 
Window Menu 
The Window menu offers the following commands: 
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Cascade  Arrange opening file windows in layers  

Tile  Arrange opening file windows in vertical direction  

Window 1, 2…… Go to a specific file window  

 
Cascade Command 
Use this command to arrange current opening file windows in layers in the program 
window  
 
Tile Command 
Use this command to arrange current opening file windows in vertical direction in the 
program window  
 
Window 1, 2,… Command 
The program displays a list of current opening file windows at the bottom of the Window 
menu. A checkmark appears in front of the file name of the active window. Choosing a file 
from this list will make its window active.  
 
Help Menu 
The Help menu offers the following commands:   
Help Topics Display help contents 
What is New Display new features and functions of the program  
Tip of the Day Display tips for using the program 
Bug Report Send us reports of the program problems   
Feedback Send us feedback as to the program 
About IrAnalyser Display edition information of the program 
 
Help Topics Command 
Use this command to get help details for the program. You can go through all the contents 
by clicking words with hyperlink.  
 
What is New Command 
Use this command to know about new features and functions of the program. 
 
Tip of the Day Command  
Use this command to open the dialog box Tip of the Day.  
 
Bug Report Command  
Use this command to create and send reports of the program bugs or problems to us. 
Choosing this command will open the dialog box Bug Report.  
Note:  
 Clicking button Send Mail will allow you to write and send an 

email to us to report the program bugs or problems.  
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 Clicking button Create System Info will allow the program to create a document Back 
Info under the directory where you install the program, showing information of your 
computer configuration. After the document is generated, the program will 
automatically attach it to the email you will send to us. Clicking button Open will open 
this document.   

 Clicking button Open under Picture will allow you to choose an IR, JPG, IRI or IMG 
image and attach it to the email you will send to us. 

 Clicking button System Info will make the program to open document System 
Information, displaying detailed information of your computer. You can edit and save 
the document as per requirements.   

 
Feedback Command 
Use this command to send your feedback about the program to us through email.  
 
About IrAnalyser Command 
Use this command to get information of the program edition, copyright, your computer 
information and our website. C 
rati 

Infrared Video  
 
General Information                                                                          
The infrared video with temperature information taken by TP8 can be transferred to PC 
through USB2.0 for further analysis by Guide software. Before the communication please 
install the USB drive into your computer� 
Also the other cameras of Guide such as IR236, IR810,IR220 can be connected with PC 
and controlled by the software too. 
 
PC System Requirements 
Operating system: Window 2000 or higher (IE5.0 or higher) 
Software: Microsoft® Office 2000 or higher 
Hardware:  
Processor Pentium 4 2.4G or Above 
RAM At least 512M 

Others Independent Graphic Card 

 

Commands in Main Menu 
 
Setup Command  
Use this command to set a directory on the hard disks to store the infrared video, capture 
image and set other relevant information.  
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Film: set the directory path to save the video recording 
Capture Saved: set the directory path to save the captured image 
Frame: set the frame of thermal image per second. The default value is 25/ second 
Palette: set the palette to be used for the infrared video 
Update track: update the interval between track circles 
After saving the setup, the program will automatically go to the directory when opening 
infrared video and perform the relative commands. 
 
Video Command 
Use this command to get infrared video from the camera such as TP8 directly or from the 
directory path of the PC where the films are saved 

 

 Device Video 
Make sure the camera of TP8 is under normal working status and connect the TP8 with 
the PC via USB2.0 to activate this command; it will bring a dialog box as following 
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Select TP8 and press ok to confirm, the infrared video is open as following 

 

 

 
 

You may pause video, or make recording, operate shutter or control the camera in the 
above real-time status. 
There are several short-cuts in the window to active the commands to operate the camera 
and the infrared video. 

 : Play infrared video. If it is play mode, perform this command to change it to pause 
mode.  

: Pause infrared video. If it is pause mode, perform this command to change it to play 
mode 

: Make the video go forward by one frame when playing video.   
: Make the video go backward by one frame when playing video. 

F2: Operate shutter 
F3: Near focus adjustment 
F4: Far focus adjustment 
F5: Camera Control  

 : Record the video capture by TP8 and save it in appointed directory. The default 
saving directory is in the sub-directory of capture under installation directory. Computer 
system will denominate the video file automatically.  
Perform this command again after stopping record.  
 
 Open Film 
Use this command to open the saved Video file in the directory path of PC. The software 

Play/Pause 

Record 

Shutte  
r 

Record 
analysis Capture Full screen 
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will play this file and further analysis can be done on it. 

 
The infrared video will be open as following 
 

 

 

 

 
There are several short-cuts in the window to active the commands to operate the infrared 
video. 

 : Play infrared video. If it is play mode, perform this command to change it to pause 
mode.  

: Pause infrared video. If it is pause mode, perform this command to change it to play 
mode 

: Make the video go forward by one frame when playing video.   
: Make the video go backward by one frame when playing video. 
 

Forward        Play/Pause 
 

Backward 
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Commands in Menu bar 
 
Video Menu  
The File menu offers the following commands: 
Palette Command  
Select a palette for the current infrared video. Nine palettes as follows are available. 

 
Auto adjustment command 
 Use this command to choose adjust image color automatically or manually. 
 Auto adjustment: the system mapped every image to the appointed pseudo color 

according to its temperature. 
 Manual adjustment: mapped the temperature range to the appointed palette via 

appointing the maximum and minimum temperature, then the image will be 
displayed. User can observe the image of appointed temperature range via manual 
adjustment. 

Note: 
Manual adjustment is to adjust temperature range. The image will be under manual mode 
after adjusting the temperature. Execute this command to return to auto mode.  
 
Gauge Setting Command  
The program establishes a mapping function for temperature and brightness of each 
image file. This command utilizes this mapping function to adjust brightness of the current 
opening image file. Dialog box of Temp Range will appear after choosing this command.  
 
TP8 control command   
Through the software, the users could operate the camera as the following 
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Calibration (F2) Select this option or Press F2 to send calibration command to the camera  

Filter 1  Switch to Filter 1 

Filter 2  Switch to Filter 2  

Near Focus (F3) Press F3 continuously to adjust near focus, stop adjusting by releasing the bottom  

Far Focus (F4) Press F4 continuously to adjust far focus, stop adjusting by releasing the bottom  

 
IR236 control command 

IR236 can be controlled when it is connected to PC in real-time status . IR236 is an on-line 

thermal camera enabling long-time examination with high accuracy. The system includes 

thermal and visual video output and can be used for human body examination and 

industry purpose. 

For detailed information, please refer to IR236 control command manual. 
 
Video capture command  
When playing infrared video, use this command under Video Menu or Press Ctrl + T to 
capture the current image.  
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The capture image can be done as following 
 Save as .IRI file or .JPG file to the appointed directory path 
 Open as new .IRI or .JPG file 
 Save as .IRI file or .JPG file and open it 
Note: 1. For TP8, the file format is .JPG 
2. The captured image is stored in the path re-set. 

 

 
Play command  
Use this command or press  to play infrared video. If it is play mode, perform this 
command to change it to pause mode.  
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Pause Command  
Use this command or press  to pause infrared video. If it is pause mode, perform this 
command to change it to play mode. 
 
Frame Forward command 
Use this command or press  to make the video go forward by one frame when playing 
video. 
 
Frame Backward command 
Use this command or press  to make the video go backward by one frame when playing 
video. 
 
Record command  
Use this command or press  to record the video capture by TP8 and save it in 
appointed directory. The default saving directory is in the sub-directory of capture under 
installation directory. Computer system will denominate the video file automatically.  
Perform this command again after stopping record. 
 
Note: Saved video can be opened with the software and do further analysis. Click 
command open film under sub-menu video in the file menu to open a saved video.  
 
Measure Menu  
Temp Unit command 
There are two temperature units selectable 
Choose degrees Celsius as temperature unit 

 
Choose degrees Fahrenheit as temperature unit 

 

 
Show Max Temp Pos 
Use this command to indicate location of the point that has the max temperature of 
infrared video by using symbol ×. 
After choosing this command, the symbol × will appear immediately in the image file to 
indicate where the point is, and also the temperature value will be indicated beside too. 
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Show Min Temp Pos 
Use this command to indicate location of the point that has the minimum temperature of 
infrared video by using symbol +. 
After choosing this command, the symbol × will appear immediately in the image file to 
indicate where the point is, and also the temperature value will be indicated beside too. 

 
 
Show Track View 
Use this command to display temperature TrackView of spot, lines or areas added to the 
infrared video 
For spot, it will display the temperature TrackView of the spot. 
For lines or areas, it will display the TrackView of the average temperature of the selected 
lines or areas. 
Click this command after adding the spots, lines or areas, the TrackView will display as 
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following. 

 

 

You can change the TrackView Lines Color by changing the property of the selected 
object. The TrackView Line color is the same as that of the selected object. 

 

 
Selecting the Track View and double click the left bottom of the mouse, a dialog box of 
TrackView settings will be brought as following. You can change colors and the 
background of the rectangular coordinates if you wish. Click Button OK to save changes 
and Button Cancel to cancel. 
 

    
 
You can also change the Min Temperature and Max Temperature of the Y-axis so that the 
TrackView could be displayed more suitably to the different application 
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Pressing F11 can save the current TrackView as JPG file in the directory path of captured 
picture of the infrared video. The suggestive information is written in the Status Bar at the 
bottom of Program Window 

 
After pressing F11, the TrackView will be saved in the capture saved directory 

 

 
 
Other Commands 
The other commands such as Isotherm Command, Histogram Command are the same as 
the measurement commands for the thermal image. 
 
Tools Menu  
Temperature Alarm Command 
This command is set for the temperature Alarm  
 Alarm Setting: Set the temperature to alarm, if you select Max and set the relative 

value, the PC will give an alarm when the temperature exceeds the set value. If you 
select Min and set the relative value, the PC will give an alarm when the temperature 
is lower than the set value 
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For recording purpose, the user could capture the picture of alarm and save them 
under the same path as normal captured picture. The picture will be saved 
automatically according to the set interval.  

 
 Enables Alarm(Ctrl+A): Choose this command to active the alarm function. Only 

when you select by √, the function is available. 

 

NOTE: The sound alarm is named as [Alarm.wav] in the installation directory. Users could 
change the sound freely in condition that remaining the same file name as 
Alarm.wav. 

 
Auto Capture Command 
This command is set for the picture capture automatically  
 Auto Capture setting: Set atuo capture interval, you can set according to time and 

also the frame frequency. For example if you set 1 second, the software will capture 
one picture every one second. If you select 30 frame, then every 30 frame a picture 
will be saved automatically. 

 

 Enables Auto Capture (Ctrl+A): Choose this command to active the auto capture 
function Only when you select by √, the function is available. 
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Record Analysis Data Command 
Use this command to export real-time temperature data analysis result of the analysis 
objects in infrared Video in .txt file or charts. It can display the real-time spot temperature, 
line or area Max, Min and Avg Temperature according to different intervals. 

click  in the bar of                                             or select Menu 

“Tools” and then “Record Analysis Data” to run this command. A dialog box will display as 
follows: 
 
 
 
 
 
 
 
 
 
 
 
 
   
 
 
 
 
 
 
 
 
There are two analysis modes, one is in File, the other is in Charts 
 First select the objects to be analysed such as R1 and S1, then set the interval of 

temperature analysis information by time or frame. Select “File” and click button 
“Start” when infrared video is playing, the temperature information of analysis objects 
will appear in Data List.  
 

 
 
 



User Manual                                                                    

 
 
 
 
 
 
 
 
 
 
 
 
    
 
 
 
 
When “Auto Refresh” is selected, the data list will display the newest information. When 
“Auto Refresh” isn’t selected, click “Previous” will go to the previous page of recording, 
click “Next” will go the next page of recording, click “Refresh” will update the recording. 
 
Click “Stop” to stop the data recording. 
 

 
 
 

 



User Manual                                                                    

The temperature data will be saved as .txt file in the directory of the captured picture is in. 
The default directory is C:\Program Files\Guide 
IrAnalyser\Capture\IRObject2008-02-25161157.txt. Click “Open File” to open the txt. file 
directly as follows 

 
Click “Exit” to exit this command 
 When the analysis mode is charts, the data list will show in charts. 
First select the objects to be analyzed such as R1 and S1, and then set the interval of 
temperature analysis information by time or frame. Select “Charts” and click button “Start” 
when infrared video is playing, the temperature information of analysis objects will appear 
in Charts 
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The following settings are for different types of chart may be needed: 
3D: display the chart in 3D mode. The sliding bar is used to adjust the depth of 3D effect. 
Show Point: display the point position in the chart according to interval. 
Show Marks: display the temperature of the point 
Scales: select “Automatic”, the temperature scale of Y-axis will be displayed automatically. 
If not selected, the Min value of Max Value of Y-axis can be set. 
Xcount: change the scale of X-axis. 

 
 
The following chart is in 3D mode. 
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Note: The temperature data of different analysis objects such as spot, line, and area will 
be displayed in different colors as follows. 
 
View Menu, Window Menu, Help Menu 
Refer to View Menu, Window Menu, Help Menu for image analysis 
 
 
 
 
 

Creating an Inspection Report with Microsoft○R Word  
an Inspection Report with Microsoft® Word 
General Information                                                                  
The program works together with Microsoft® Word to create inspection reports. 
When creating a report, the program adds four menus to the Microsoft® Word menus. 
Basic commands regarding creating a report are included in these four menus. You can 
use them to insert all the information of the image file for which a report will be created into 
the report, and then edit the report with other Microsoft® Word menus. 
 
Using the Menu                                                                      
Choose sub-command report>word>new under command Report of menu File. A report 
as shown below will open in the program window. 
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Four menus of the program appear in the Microsoft® Word menus: File, Report, Windows 
and Help. 
 
File Menu 
The File menu offers the following commands: 

Open Image Open an existing image file  
Save  Save the current report  
Print Print the current report 
External Device 
Manager 

Delete saved image files in TP8 camera/ M-series camera or 
download them from TP8 camera/ M-series camera to your PC.  

Close  Close the current report  
Exit  Exit the Guide IrAnalyser® program  

 
Open Command  
Use this command to open an existing image file in a new window. You can open multiple 
image files at one time. Use the Window menu to switch among the multiple opening files. 
More details, please refer to Window 1, 2, ... command.  

Save Command  
Use this command to save the current editing report in its current or a different name and 
directory.  
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Print Command  
Use this command to print the current editing report  

External Device Manager Command  
This command contains a sub-command Device Manager. Using this command can 
delete files saved in TP8 camera or download them from TP8 camera to your PC.  
After installing the USB driver and connecting TP8 camera to your PC, choosing this 
command will open a dialog box for you to download or delete all the image files. Clicking 
Button Copy All allows you to download all the images saved in TP8 camera to your PC, 
with the progress shown in status bar. When the status bar us fully filled, download is 
completed. Clicking Button Delete All will eliminate all the image files from the built-in flash 
memory of TP8 camera. Clicking Button Quit can exit the command.  
 

Note: 
 This command is unavailable unless TP8 camera is connected to your PC and the 

USB driver is installed in your PC.  
 You can connect TP8 camera to your PC through USB extension cable supplied with 

TP8 camera.  
 

Close Command  
Use this command to close the current report  

Exit Command  
Use this command to end your Guide IrAnalyser® session. After choosing this command, 
the program will prompt you to save image files with unsaved changes.  
 

Report Menu  
Commands under the Report menu carry out most of the basic procedures to create a 
report.  

 

Select Image  
Choose one from current opening thermal images to create a report 
for  

Insert Thermal Image  Insert the selected thermal image into the report  

Insert Photo  
insert the visual image saved together with the selected thermal 
image or other visual images stored in your computer (if any) into 
the report. 

Insert Profile  
Insert profiles of the lines added to the selected thermal image (if  
any) into the report  

Insert VoiceComment 
Insert the voice annotation of the selected thermal image into the 
report 

Insert Property  Insert property of the selected thermal image into the report  
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Insert Histogram  

Image Histogram: Insert histogram of the selected thermal image  
into the report  
Other Histogram: Insert histograms of analysis objects added to the 
selected thermal image (if any) into the report 

Insert Analysis Result  Insert data of all the analysis objects added to the selected thermal  
image into the report  

Insert Analysis  Select analysis objects added to the selected thermal image and  
insert their data into the report  

 

Select Image Command  
Use this command to choose one from the current opening thermal images to create a 
report  
for it.  
When there are several opening thermal images in the program window, 
Choosing this command will open the dialog box to prompt you to select one. Click the image 
name to be chosen and click Button OK to select it. Then the report will be created for this 
image.  

 

 
Note:  
 When there is only one opening thermal image in the program window, the program 

will automatically choose it to create the report.  
 When there are several opening thermal images in the program window, choosing 

one image name from the form  in the toolbar will do the same as 
using this command.  

 
 
Insert Thermal Image Command  
Use this command to insert the selected thermal image into the report.  
When there are several opening thermal images in the program window, the command is  
unavailable unless you choose one image from them by using the command Select Image.  
When there is only one opening thermal image in the program window or after you choose 
one  
image, clicking this command will insert the image to the report.  
 
Note: 
 Clicking shortcut icon  in the toolbar can activate this command as well.  
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Insert Photo Command  
Use this command to insert the visual image saved together with the selected thermal 
image or other visual images stored in your computer (if any) into the report.  
It will bring a dialogue box as following 

 

Choose ‘Y’ to insert other visual images(not the visual ones for the selected thermal image) 
in the computer into the report.  
Choose “N” to insert the visual image of the selected thermal image into the report 
Choose “Cancel” to exit Insert Photo Command 
 

Note: 

 Clicking short icon  in the toolbar can activate this command as well.  

Insert Profile Command  
Use this command to insert profiles of lines added to the selected thermal image (if any) 
into the report. 
 
Note: 

 Clicking short icon  in the toolbar can activate this command as well.  

 This command is not available until a thermal image is selected. 
 
Insert Property Command  

Use this command to insert property of the selected thermal image into the report.  
Choosing sub-command Property Table under this command will insert into the report all 
the  
data when taking the selected thermal image. The data will be listed in the form of a table.  
Choosing other sub-commands only inserts their respective value into the report.  
 
Note: 

 Clicking shortcut icon  in the toolbar can activate this command as well. 

You can choose whether to insert all the data or a specific item value to the report 
from the sub-options by clicking next to property.  

 This command is not available until a thermal image is selected.  
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Insert Histogram Command  
This command includes two sub-commands as follows:  
Image Histogram: Use this command to insert histogram of the selected thermal image 
into the report  
Other Histogram: Use this command to insert histogram of an analysis object (a line, 
rectangle, circle or polygon) added to the selected thermal image (if any) into the report. 
After choosing it, a dialog box View Histogram will appear to prompt you to choose the 
object whose histogram will be inserted into. Click on the object name and click Button 
View, then its histogram is added into the report.  
 

 
Note:  
 Clicking short icon  in the toolbar can activate this command as well. You can 

choose whether to insert the image histogram or other histogram by clicking button 
at the right hand. 

 This command is not available until a thermal image is selected. 
 

Insert Analysis Result Command  
Use this command to insert data of all the analysis objects (a spot, line, rectangle, circle, 
polygon or a pair of delta-two spots) added to the selected thermal image (if any) into the 
report in the form of a table.  
Note:  
 Clicking short icon  in the toolbar can activate this command as well.  
 This command is not available until a thermal image is selected. 
 

Insert Analysis Command  
Use this command to choose some analysis objects (spot, line, rectangle, circle, polygon 
or a pair of delta-two spots) added to the selected thermal image (if any) and then insert 
data of the selected objects into the report in the form of a table.  
 

After choosing this command, a dialog box Insert Analysis Table will appear to prompt you 
to choose the object whose data will be inserted into. Choose the object and click button 
OK to add its data into the report.  
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Note:  
 This command is not available until a thermal image is selected. 
 After using these commands above, all the information regarding the selected 

thermal image is included in the report. You can add more information to it and edit it 

with other Microsoft
®
 Word commands if necessary.  

 After editing, choose Save command under File menu to save the report.  

Window Menu 
The Window menu offers the following commands: 

Cascade  Arrange opening file windows in layers  

Tile  Arrange opening file windows in vertical direction  

Window 1, 2…… Go to a specific file window  

 
Cascade Command 
Use this command to arrange current opening file windows in layers in the program 
window  
 
Tile Command 
Use this command to arrange current opening file windows in vertical direction in the 
program window  
 
Window 1, 2,… Command 
The program displays a list of current opening file windows at the bottom of the Window 
menu. A checkmark appears in front of the file name of the active window. Choosing a file 
from this list will make its window active.  
 
Help Menu 
The Help menu offers the following commands:   

Guide IrAnalyser Help Display help contents of Guide IrAnalyser® program 
Microsoft® Office Word Help Display help contents of Microsoft® Word 
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Guide IrAnalyser Help Command  
Use this command to view help contents for the program. You can choose different 
sub-commands to go through their respective contents.  

Microsoft Office Word Help Command  
Use this command to get help contents of Microsoft® Word. You can choose different 
sub-commands to go through their respective contents.  
 
Toolbar Description                                                                         

The toolbar provides shortcuts to major functions in the report.  
Shortcut  Description  

 Select Image Button  

 Insert Thermal Image Button  

 Insert Photo Button  

 Insert Profile Button  

 Insert Analysis Result Button  

 Insert Property Button  

 Insert Histogram Button  
For more information about the shortcut icons, please refer to the sections of their 
corresponding command under menu Report.  
 

Creating a Report                                                                                                                                                        
 Choose sub-command Report>Word>New under command Report of menu File.  
 A report window as shown below will open in the program window.  
 

 

 Input the report title and other general information to the blank report.  

 Choose command Open Image under menu File to open a thermal image.  
 If you have opened several thermal images, choose command Select Image to 

select one from them.  
 Choose command Insert Thermal Image under menu Report to insert the thermal 

image or the selected thermal image to the report.  
 (If you have opened one thermal image before creating a blank report, the program 
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will automatically regard the report is to be created for the thermal image. In this 
case, you can directly choose command Insert Thermal Image to insert the image 
without re-opening it.)  

 Choose command Insert Photo under menu Report to insert the visual image 
saved together with the selected thermal image or other visual images stored in 
your computer (if any) into the report. 

 Choose other commands under menu Report to insert all the relevant information 
to the report.  

 Edit the report with other Microsoft
®
 Word menus and commands. 

 Choose command Save under menu File to save the report.  
 

Creating an Inspection Report with The Report Wizard   
 
General Information                                                                     

Before creating an inspection report using the report wizard, a report template (a *.dot file) 
must have been previously created and a thermal image has been chosen to create the 
report for.  
 

Note:  
 The program is supplied with 3 kinds of report templates (called 

ReportTemplate1.dot, ReportTemplate2.dot and ReportTemplate3.dot) for your 
basic use. Also you can create customized report templates. More details please 
refer to next section- Creating an inspection report based on a customized report 
template.  

 ReportTemplate1, ReportTemplate2 and ReportTemplate3.dot are under the 
directory where you install the program to your PC. If you do not change the default 
directory during installation, you can find it under C:\Program Files\Guide 
IrAnalyser\Templates.  

 Every time you run the program to create an inspection report, the program will 
choose ReportTemplate1 or ReportTemplate2 or ReportTemplate3 as the default 
report template. You can choose other templates (if any) to create a report as well.  

 
Creating a Report                                                                                                                                
 Choose sub-command Report Wizard under command Report of menu File.  
 A dialog box Open will appear to prompt you to select a report template before 

creating the report.  
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 Click a template name and button Open will apply the selected template to the report 
creation.   

 Follow the report wizard (5 steps in total) to create the report.  
 In Step 2 of the wizard, you can edit the document properties by selecting a specific 

item at a time, double clicking it and then editing its property in the dialog box.  

 
 Step 3, select the thermal image(s) you want to input in to the report.  

 
 Step 4, select a thermal image name, then its thumbnail image and visual image (if 

any) will be displayed in the two blanks at the bottom. If the visual image is not saved 
with the thermal image, select the image name and then click the blank under Photo 
to input its corresponding visual image to the report.  

 

 Click button Next to go through all the five steps.  
 After the report wizard dialog box disappears, the program will prompt you to save the 

report. Choose a directory to save it.  
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 Then a dialog box appears to prompt you to save, print or open the report. Choosing 
Save and Open it allows you to view it immediately. 

  
 
 
 
 
 
 

 After opening the report, you can edit it further as instructed in the above section- 

Creating an inspection report with Microsoft
®
 Word. 

Note:  
Create report in Excel format is also available. Detailed processes are exactly the same 
as creating report in Word format. 

 

General Information                                                                  

As the report template supplied with the program may be too simple to use, you can 
create customized templates according to your specific requirements. Then you can 
create inspection reports based on these new templates.  
Note:  
 Creating a report template requires skill in creating document templates in Microsoft® 

Word. For more information about this, please refer to your Microsoft® Word 
documentation or the Microsoft® Word online help.  

 Choosing a report template is only required when creating a report using the report 
wizard. The command Report wizard is unavailable unless a thermal image has been 
opened in the program window.  

 

Creating a Report Template based on the Existing Template ReportTemplate.dot                           
 
Introduction  
It is the easiest to modify an existing report template so as to create a customized report 
template. You can take use of the existing infrared objects already included in the 
template and save a lot of time compared to creating a template from scratch.  
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Note:    
 You can change any information in the template ReportTemplate.dot, but it is 

advisable that you do not modify information included in <##> (e.g. <#PageStart#>), 
which is automatically input by the program.  

 After you save change made to the template ReportTemplate.dot, the program will 
always utilize this new version to create reports. You cannot resume its original 
information unless you reinstall the program.  

 

Creating a report template based on ReportTemplate.dot     
 Find out where the template ReportTemplate.dot is. The default directory where 

ReportTemplate.dot lies is C:\Program Files\Guide IrAnalyser\Templates  
 Open ReportTemplate.dot in this way: Select ReportTemplate.dot, click right button of 

the mouse and choose command Open to open it  
 Modify the content of ReportTemplate.dot  
 Save the modified ReportTemplate.dot and close it  

Note:   
 Please never try to double click ReportTemplate.dot to open it. In Microsoft® Word, 

double clicking a template file will open a new Word file (*.doc) rather than open the 
selected template file (*.dot).  

 In ReportTemplate.dot , please do not modify information included in <##> (e.g. 
<#PageStart#>), which is automatically input by the program.  

 
Creating a Report based on the Modified Template ReportTemplate.dot                         

Two ways are available to create a report based on the modified ReportTemplate.dot. 
One is creating it with Microsoft® Word. The other is creating it using the report wizard.  
More details please refer to the two sections above: Creating an inspection report with 
Microsoft® Word and Creating an inspection report using report wizard.  
 
Creating a Customized Report Template                                                

 A report template file is essentially a Microsoft® Word document template file.  
 There are two ways to create a Microsoft® Word document template file.   
 
 Create a new Microsoft® Word document and then save it as a file of document 

template  
 Create a new Microsoft® Word file.  
 Open and edit it as per your requirement.  
 Choose command Save As to save it as a document template file. In the 

dialog box save as, enter the file name, choose Document Template as the 
file type and then choose a directory to save it.  

 Please do remember where you save it so that you can find it when 
choosing templates to create reports. The default directory for Microsoft® 
Word Document Template files is the folder where Microsoft® lies in your 
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operating system.  
 

 Copy the template ReportTemplate.dot, modify the copied file and then save it.  
 Select ReportTemplate.dot, copy and paste it in a folder you want to store it. 

A template file named Copy of ReportTemplate.dot will exist.  
 Rename it if you wish 
 Select it, click right button of the mouse and choose command Open to open 

it  
 Modify its content as per your requirement.  
 Choose command Save to save it in the original name or Save As to save it 

as a new file in a new name. And save it in a specific directory.  
 Please do remember where you save it so that you can find it when 

choosing templates to create report. The default directory for 
ReportTemplate.dot is C:\Program Files\Guide IrAnalyser\Templates. If you 
save it together with ReportTemplate.dot, you can directly go to the folder 
above to choose it.  

 

Now, the new report template is available for creating a report based on it.  
Note:   
 You can save new templates in the same folder Templates as ReportTemplate.dot or 

in a different folder. If you save it in a different folder, you need to go to the folder to 
choose it when you creating reports.  

 You can set up the directory where to save report templates using command Setup 
under menu File of the program. The program will automatically go to the directory to 
find a template when creating a report.  

Creating a Report based on the New Report Template                                           

Choosing a report templates is only required when creating a report using the report 
wizard. 
 Open one or several thermal images.  
 Choose sub-command Report Wizard under command Report of menu File.  
 A dialog box open will appear to prompt you to select a report template before 

creating the report. Now go to the directory where you save the templates and choose 
one you want to use.  
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 Follow the steps of Report wizard to create a report.  
 More details please refer to the section above: Creating an inspection report using 

report wizard.  
 

 
Emissivity 

 
What Is Emissivity? 
The standard of radiation is "blackbody" radiation which exists in any enclosure whose 
walls are at a uniform temperature. The shape of the enclosure and the wall material have 
no effect on this radiation, it being a function of temperature alone. 
 
A small hole in such an enclosure only affects this radiation level very slightly. The area of 
the hole should not exceed 5% of the area of the walls of the enclosure, when the 
radiation passing through the hole is within about one part in a thousand of the blackbody 
radiation level defined by the wall temperature. Such a device is fairly easy to build and 
forms the source on which all thermometers are calibrated. 
 
A surface always emits less radiation than would a black body at the same temperature by 
a factor called the "emissivity" of the surface. 
 
Emissivity =  Radiation emitted by surface/ Radiation emitted by black body 
 
How Do We Deal With Emissivity? 
If we ignore the emissivity altogether and infer a temperature from the thermometer output, 
we shall get a temperature lower than the true temperature by an amount depending on 
the value of emissivity and the characteristics of the thermometer. This temperature is 
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known as the "apparent" or "brightness" temperature of the surface. If the emissivity is 
constant, this temperature rises and falls in exactly the same way as the true temperature 
and this may be sufficient for some purposes. 
 
More often the true surface temperature is required. We have: 

Actual output = E x output when viewing blackbody 
To obtain the true surface temperature we must divide the actual output by the emissivity 
value E before we convert to temperature. 
 
This is done by setting the emissivity control to the appropriate value. 
It is therefore necessary to know the value of the emissivity. There is a vast amount of 
data available, unfortunately much of it is confusing because substantially different values 
are quoted. This is because emissivity depends upon: 
 
a) The basic material 
b) Surface condition - roughness and oxidation 
c) Temperature 
d) Angle of view 
e) Wavelength 
 
For materials with smooth, clean (unoxidised) surfaces, emissivities are usually in the 
range 0.05 to 0.50 and are usually very wavelength dependent, being higher at shorter 
wavelengths. The appropriate settings for the IR Thermal Cameras of Guide are given in 
the following tables. It must be remembered that these are only guideline figures. They 
can be substantially increased if the surface is rough or even slightly oxidised. 
 
The values quoted for oxidised metals assume that the metal is heavily oxidised. Thin 
oxide layers will give an emissivity value between this and the value for an unoxidised 
surface. 
 
If a more precise emissivity value is needed or more information is required on how to 
obtain the emissivity value of a specific material, please contact us. 
 
 

 

 
 
 



User Manual                                                                    

 

 

Typical Emissivity Values 

 

Refractories Miscellaneous 

Alumina 0.40 Asphalt 0.90 

Red Brick 0.93 Carbon >0.90 

Graphite 0.85 

Alloys  Soot 0.95 

Brass 0.10 Cement & Concrete 0.90 

Oxidized 0.61 Cloth 0.85 

 

Metals 

Aluminium 0.05 

Oxidized 0.30 

Chromium 0.15 

Cobalt 0.18 

Gold 0.02 

Iron & Steel 0.18 

Oxidized 0.85 

Lead 0.16 

Oxidized 0.63 

Magnesium 0.12 

Nickel 0.15 

Platinum 0.10 

Silver 0.03 

Tin 0.09 

Titanium 0.30 

Tungsten 0.13 

Zinc 0.05 

Oxidized 0.11 

 

 


